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::COMPUTER KNOWLEDGE:: 

 

1. __________ allows users to upload files to an online site so they can be viewed and edited from 

another location. 

(a) General-purpose applications 

(b) Microsoft Outlook 

(c) Web-hosted technology 

(d) Office Live 

(e) None of these 

2. What feature adjusts the top and bottom margins so that the text is centered vertically on the printed 

page ? 

(a) Vertical justifying 

(b) Vertical adjusting 

(c) Dual centering 

(d) Horizontal centering 

(e) Vertical centering 

3. Which of these is not a means of personal communication on the Internet ? 

(a) chat 

(b) instant messaging 
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(c) instanotes 

(d) electronic mail 

(e) None of these 

4. What is the overall term for creating, editing, formatting, storing, retrieving, and printing a text 

document ? 

(a) Word processing 

(b) Spreadsheet design 

(c) Web design 

(d) Database management 

(e) Presentation generation 

5. Fourth-generation mobile technology provides enhanced capabilities allowing the transfer of both 

__________ data, including full-motion video, high-speed Internet access, and video conferencing. 

(a) video data and information 

(b) voice and nonvoice 

(c) music and video 

(d) video and audio 

(e) None of these 

6. __________ is a form of denial of service attack in which a hostile client repeatedly sends SYN 

packets to every port on the server using fake IP addresses. 

(a) Cyborgaming crime 

(b) Memory shaving 

(c) Syn flooding 

(d) Software piracy 

(e) None of these 

7. Which of these is a point-and-draw device ? 

(a) mouse 

(b) scanner 

(c) printer 

(d) CD-ROM 

(e) Keyboard 

8. The letter and number of the intersecting column and row is the __________. 

(a) cell location 

(b) cell position 

(c) cell address 

(d) cell coordinates 

(e) cell contents 
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9. A set of rules for telling the computer what operations to perform is called a __________. 

(a) procedural language 

(b) structures 

(c) natural language 

(d) command language 

(e) programming language 

10. A detailed written description of the programming cycle and the program, along with the test results 

and a printout of the program is called __________. 

(a) documentation 

(b) output 

(c) reporting 

(d) spec sheets 

(e) Directory 

11. Forms that are used to organize business data into rows and columns are called __________. 

(a) transaction sheets 

(b) registers 

(c) business forms 

(d) sheet-spreads 

(e) spreadsheets 

12. In Power Point, the Header and Footer button can be found on the Insert tab in what group ? 

(a) Illustrations group 

(b) Object group 

(c) Text group 

(d) Tables group 

(e) None of these 

13. A(n)_________is a set of programs designed to manage the resources of a computer, including 

starting the computer, managing programs, managing memory, and coordinating tasks between input 

and output devices. 

(a) application suite 

(b) compiler 

(c) input/output system 

(d) interface 

(e) operating system (OS) 

14. A typical slide in a slide presentation would not include __________. 

(a) photo images charts, and graphs 

(b) graphs and clip art 
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(c) clip art and audio clips 

(d) full-motion video 

(e) content templates 

15. The PC productivity tool that manipulates data organized in rows and columns is called a 

__________. 

(a) spreadsheet 

(b) word processing document 

(c) presentation mechanism 

(d) database record manager 

(e) EDI creator 

16. In the absence of parentheses, the order of operation is __________. 

(a) Exponentiation, addition or subtraction, multiplication or division 

(b) Addition or subtraction, multiplication or division, exponentiation 

(c) Multiplication or division, exponentiation, addition or subtraction 

(d) Exponentiation, multiplication or division, addition or subtraction 

(e) Addition or subtraction, exponentiation, Multiplication or division 

17. To find the Paste Special option, you use the Clipboard group on the _____ tab of PowerPoint. 

(a) Design 

(b) Slide Show 

(c) Page Layout 

(d) Insert 

(e) Home 

18. An _____ program is one that is ready to run and does not need to be altered in any way. 

(a) interpreter 

(b) high-level 

(c) compiler 

(d) COBOL 

(e) executable 

19. Usually downloaded into folders that hold temporary Internet files, _____ are written to your 

computer's hard disk by some of the Web sites you visit. 

(a) anonymous files 

(b) behaviour files 

(c) banner ads 

(d) large files 

(e) cookies 
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20. What is the easiest way to change the phrase, revenues, profits, gross margin, to read revenues, 

profits, and gross margin ? 

(a) Use the insert mode, position the cursor before the g gross, then type the word and followed by a space 

(b) Use the insert mode, position the cursor after the g in gross, then type the word and followed by a space 

(c) Use the overtype mode, position the cursor before the g in gross, then type the word and followed by a 

space 

(d) Use the overtype mode, position the cursor after the g in gross, then type the word and followed by a space 

(e) None of these 

21. A program, either talk or music, that is made available in digital format tor automatic download over 

the Internet is called a __________. 

(a) wiki 

(b) broadcast 

(c) vodcast 

(d) blog 

(e) podcast 

22. Which PowerPoint view displays each slide of the presentation as a thumbnail and is useful for 

rearranging slides ? 

(a) Slide Sorter 

(b) Slide Show 

(c) Slide Master 

(d) Notes Page 

(e) Slide Design 

23. Different components on the motherboard of a PC unit are linked together by sets of parallel 

electrical conducting lines. What are these lines called ? 

(a) Conductors 

(b) Buses 

(c) Connectors 

(d) Consecutives 

(e) None of these 

24. What is the name given to those applications that combine text, sound, graphics, motion video, 

and/ or animation ? 

(a) motionware 

(b) anigraphics 

(c) videoscapes 

(d) multimedia 

(e) maxomedia 
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25. A USB communication device that supports data encryption for secure wireless communication for 

notebook users is called a __________. 

(a) USB wireless network adapter 

(b) wireless switch 

(c) wireless hub 

(d) router 

(e) None of these 

26. A(n) __________ language reflects the way people think mathematically. 

(a) cross-platform programming 

(b) 3GL business programming 

(c) event-driven programming 

(d) functional 

(e) None of these 

27. When entering text within a document, the Enter key is normally pressed at the end of every 

__________. 

(a) Line 

(b) Sentence 

(c) Paragraph 

(d) word 

(e) file 

28. When a real-time telephone call between people is made over the Internet using computers, it is 

called __________. 

(a) a chat session 

(b) an e-mail 

(c) an instant message 

(d) Internet telephony 

(e) None of these. 

29. Which of the following is the first step in sizing a window ? 

(a) Point to the title bar 

(b) Pull down the View menu to display the toolbar 

(c) Point lo any corner or border 

(d) Pull down the View menu and change to large icons 

(e) None of these 

30. Which of the following software could assist someone who cannot use their hands for computer 

input ? 
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(a) Video conferencing 

(b) Speech recognition 

(c) Audio digitizer 

(d) Synthesizer 

(e) None of these 

31. ___________ a document means the file is transferred from another computer to your computer. 

(a) Uploading 

(b) Really Simple Syndication (RSS) 

(c) Accessing 

(d) Downloading 

(e) Upgrading 

32. Which computer memory is used for storing programs and data currently being processed by the 

CPU ? 

(a) Mass memory 

(b) Internal memory 

(c) Non-volatile memory 

(d) PROM 

(e) None of these 

33. Computers that control processes accept data in a continuous __________. 

(a) data traffic pattern 

(b) data highway 

(c) infinite loop 

(d) feedback loop 

(e) slot 

34. What refers to a set of characters of a particular design ? 

(a) keyface 

(b) formation 

(c) calligraph 

(d) stencil 

(e) typeface 

35. _________ is used by public and private enterprises to publish and share financial information with 

each other and industry analysts across all computer platforms and the Internet. 

(a) Extensible Markup Language (EML) 

(b) Extensible Business Reporting Language (XBRL) 

(c) Enterprise Application Integration (EAI) 
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(d) Sales Force Automation (SFA) software 

(e) None of these 

36. Which part of the computer is used for calculating and comparing ? 

(a) ALU 

(b) Control unit 

(c) Disk unit 

(d) Modem 

(e) None of these 

37. The method of Internet access that requires a phone line, but offers faster access speeds than dial-

up is the _____ connection. 

(a) cable access 

(b) satellite access 

(c) fiber-optic service 

(d) Digital Subscriber Line (DSL) 

(e) modem 

38. ___________ software creates a mirror image of the entire hard disk, including the operating 

system, applications, files, and data. 

(a) Operating system 

(b) Backup software 

(c) Utility programs 

(d) Driver imaging 

(e) None of these 

39. What is a URL? 

(a) a computer software program 

(b) a type of programming object 

(c) the address of a document or "page" on the World Wide Web 

(d) an acronym for Unlimited Resources for Learning 

(e) a piece of hardware 

40. What is the significance of a faded (dimmed) command in a pull-down menu ? 

(a) The command is not currently accessible 

(b) A dialog box appears if the command is selected 

(c) A Help window appears if the command is selected 

(d) There are no equivalent keystrokes for the particular command 

(e) None of these 
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41. Your business has contracted with another company to have them host and run an application for 

your company over the Internet. The company providing this service to your business is called an 

__________. 

(a) Internet service provider 

(b) Internet access provider 

(c) Application service provider 

(d) Application access provider 

(e) Outsource agency 

42. A(n) ________ allows you to access your e-mail from anywhere. 

(a) Forum 

(b) Webmail interface 

(c) Message Board 

(d) Weblog 

(e) None of these 

43. Which of the following would you find on Linkedln ? 

(a) Games 

(b) Connections 

(c) Chat 

(d) Applications 

(e) None of these 

44. ________ is a technique that is used to send more than one call over a single line. 

(a) Digital transmission 

(b) Infrared transmission 

(c) Digitizing 

(d) Streaming 

(e) Multiplexing 

45. The Search Companion can __________. 

(a) Locate all files containing a specified phrase 

(b) Restrict its search to a specified set of folders 

(c) Locate all files containing a specified phrase and restrict its search to a specified set of folders 

(d) Cannot locate all files containing a specified phrase or restrict its search to a specified set of folders 

(e) None of these 

46. Which of the following cannot be part of an email address ? 

(a) Period (.) 

(b) At sign (@) 

(c) Space () 
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(d) Underscore (_) 

(e) None of these 

47. Which of the following must be contained in a URL ? 

(a) a protocol identifier 

(b) the letters, www. 

(c) the unique registered domain name 

(d) www. and the unique registered domain name 

(e) a protocol identifier, www. and the unique registered domain name 

48. Which of the following information systems focuses on making manufacturing processes more 

efficient and of higher quality ? 

(a) Computer-aided manufacturing 

(b) Computer-integrated manufacturing 

(c) Computer-aided software engineering 

(d) Computer-aided system engineering 

(e) None of these 

49. A mistake in an algorithm that causes incorrect results is called a __________. 

(a) logical error 

(b) syntax error 

(c) procedural error 

(d) compiler error 

(e) machine error 

50. A device for changing the connection on a connector to a different configuration is- 

(a) a converter 

(b) a component 

(c) an attachment 

(d) an adapter 

(e) Voltmeter 
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